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1 Purpose 

The purpose of this environmental calculation file (ECF) is to present the methodology, input data, and 
results used to delineate three-dimensional groundwater plumes for two contaminants of concern (COCs) 
- nitrate (N03) and chromium (Cr) - in the 200-UP- l Operable Unit (OU) near and down-gradient of the 
Waste Management Area (WMA) S-SX tank fanns. The three-dimensional interpolation was carried out 
in the Leapfrog-Geo® 1 geologic modeling platfonn, which includes an interpolation engine for analyzing 
and visualizing three-dimensional data. 

Input data were derived from two-dimensional groundwater plumes developed in ECF-HANFORD- 12-
0075, Calculation and Depiction of Groundwater Contamination for the Calendar Year 201 1 (CY201 I) 
Hanford Site Groundwater Monitoring Report, and from depth-discrete groundwater samples. Data from 
the two-dimensional plumes were placed at elevations corresponding to the March 20 11 water table, and 
depth-discrete sample data were placed at the elevation of their collection depth. All interpolated plumes 
were reviewed by project scientists, and effort was made to incorporate site-specific expertise in the 
delineation of these plumes. 

1 Leapfrog Geo is a registered trademark of ARANZ Geo Limited of Christchurch, New Zealand. 
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2 Methodology 

The three-dimensional interpolation was conducted following the general methodology described in the 
subsections below. All digital files discussed in the text are stored in the Environmental Model 
Management Archive (EMMA) indexed to this ECF. 

2.1 Input Data Processing 

I. An essential reference surface used in the development of the groundwater plumes is the March 2011 
water table. This surface is in the fom1 of a raster (numerical grid) at a resolution of 100 m, 
originating from DOE/RL-2011-118, Hanford Site Groundwater Monitoring Report for 2011. This 
raster is shown in the vicinity and down-gradient of the S-SX tank farm in Figure 1, and the file 
(wt_201 J.asc) is included with this ECF as a digital file. 

2. Depth-discrete groundwater sample data for nitrate and chromium in the vicinity and down-gradient 
of the S-SX tank fann were received in file S-SX_CrNO3_DepthProfileSampleResults.xlsx. Sample 
values, well coordinates, and surface elevations were retrieved from the Hanford Enviromnental 
Information System (HEIS) database via the Environmental Dashboard Application (EDA) available 
online at https://ehs.hanford.gov/eda/. These data were reviewed by John McDonald (INTERA, 
Incorporated) to retain highest-value sample results where duplicate analyses exist, to remove 
chromium sample results where reducing conditions are likely to exist, nitrate samples likely to have 
been affected by extraction wells, and nitrate samples collected too long ago to likely be 
representative of conditions in year 2011 (see Section 5 for details) . Sample coordinates, elevations, 
and concentration values used for the three-dimensional interpolation are included in Appendix A for 
nitrate and Appendix B for chromium, and well locations with sample results for nitrate and 
chromium are respectively shown in Figure 2a and Figure 2b. 

3. The two-dimensional representations of the nitrate plumes for 2011 developed in ECF-HANFORD-
12-0075 were received as raster layer 200UPJ_Nitrate_Ave_SSX_F9.asc. The nitrate raster has a 
spatial resolution of 10 m, and concentrations are expressed in units of micrograms per liter (µg/L). 
This raster is shown in units of milligrams per liter (mg/L) in the S-SX tank fam1 area in Figure 2a. 

4. The two-dimensional representation of the chromium plumes for 2011 developed in ECF­
HANFORD-12-0075 were received as raster layers 200UPJ_Chromium_AveJ0REVasc and 
200UP J _ Chromium_AveREV_SSXF.asc. The fonner raster has a spatial resolution of 40 m, and the 
latter has a resolution of 20 m. Numerical values directly from the grid are in transfonned units 
(discussed below) and required back-transfonning to obtain units of micrograms per liter (µg/L). 

5. Geostatistical interpolation of the two-dimensional grid is described in Section 2 (Methodology) of 
ECF-HANFORD-12-0075, and input files used for kriging different data sets are given in Appendix 
C of the report. The input file used for 200UPJ_Chromium_Avel0REVasc is 
200UPJ_Chromium_Ave_Matt.txt given on page C-158 of the report, and the input file used for 
200UPJ_Chromium_AveREV_SSXF.asc is 200UPJ_Chromium_Ave_Matt_SSXtxt given on page C-
159. The header infonnation in these input files indicates that the data were transfom1ed using 
multiple-indicator kriging using the relations between output raster value and input concentration 
(same for both rasters) shown in Table I. 

2 
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Table 1. Relation Between the Chromium Plume 
Raster Value and Concentration 

Raster Value Concentration (1,19/L) 

0.95 10 

1.5 20 

2.5 48 

3.5 100 

4. 5 500 

5.5 1,000 

6.5 2,000 

7.5 5,000 

6. The original chromium rasters from ECF-HANFORD-1 2-0075 are in the converted raster values and 
were not directly converted back to concentration values (note that the nitrate rasters are useable as 
received). To accomplish the back-transfonnation of the chromium rasters to concentrations (in 
µg/L), the original rasters were first subset to the area near the S-SX tank farm and converted to point 
shapefiles. These points are located at the center of each raster cell, and spatial coordinates 
(Washington State Plane South, NAD83, 4602) were calculated for each point. The attribute table 
from these shapefiles were copied to Microsoft Excel®2, and this spreadsheet was used as an input 
file for a short Python program that maps input raster values to a Lagrange interpolating polynomial 
derived from the original kriging parameters given above and two additional (raster value, 
concentration) pairs (0, 0) and (0.3, 3), which were added subjectively to prevent erratic oscillation in 
the range [O, 0.95). The Python program writes an output Excel file, which is then used to create point 
shapefiles with the interpolated chromium concentrations at each point. These points were then 
converted to the rasters shown in Figure 2b. Files used to develop these back-transfonned rasters are 
named below and are included with this ECF as digital fi les. A graphical representation of the 
Lagrange polynomial used to back-transfonn the chromium concentrations written by the program is 
also given . 

a. Original rasters subset to the S-SX tank fann area: 

1. Subset_Ol_Cr_AveJOREV.tif 

11. Subset_Ol _Cr_AveREV_SSXF.tif 

b. Converted raster values to points using the ArcGIS toolbox Conversion Tools > From Raster > 
Raster to Point, extracted XY coordinates, and flagged obviously problematic cells for disuse 
(i.e. , cells with a "GRID_CODE" value of zero or less) in point shapefi les: 

1. rastervals_cr _original_subsetOJ _aveJOrev _051017.shp 

11. rastervals_cr _original_subsetOJ _averev _ssx/_051 OJ 7.shp 

2 Microsoft Excel is a registered product of the Mic rosoft Corporation in the United States and in other countries. 
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c. Copied attributes from these shapefiles to Excel spreadsheet 
Cr_rastervalsJor_interpolation_00_051017.xlsx, which serves as the input file for the script in 
!Python Notebook: 

1. chprc _ Rel67 _ Cr _rasters_ Lagrangelnterpolation _ 05111 7. ipynb. 

1. Uses Python 3.4; version used here installed using WinPython 64-bit distribution for 
Windows 

2. Requires modules numpy, matplotlib, and pandas 

11 . Plot of interpolating polynomial from within !Python Notebook: 

Lagrange polynomial interpolation 

5000 
for transforming chromium rasters 

4000 

3000 

:::; 

"" 2000 :s 
.::-

1000 

0 

- 1000 
0 1 2 3 4 s 6 7 6 

·g; na!ro rmlu 

111. Used script to map raster values from input file to the interpolating polynomial shown above, 
and output Excel file Cr _interpolated_ concentrations_ 05111 7.xlsx, which contains separate 
tabs for the two different rasters . 

d. Used the file Cr _interpolated _concentrations_ 05111 7.xlsx to create shapefiles of the interpolated 
chromium concentrations (µ g/L). Within the shapefiles (not the Excel file) , omitted all points 
with a "GRID_ CODE" value less than 1.00 and at locations corresponding to the areas away from 
the plumes originating from the S-SX tank fann, as indicated on Figure 2a and Figure 2b . 

1. 2011 _S-SX_Cr _interpolatedJrom_Avel0REV_0l_05121 7.shp 

11. 2011 _ S-SX_ Cr _interpolated Jrom _ AveREV _ SSXF _ 01_051217.shp 

e. Converted these point shapefiles to the following rasters using the ArcGIS toolbox Conversion 
Tools > To Raster > Point to Raster, specifying the original resolution of each raster (20 m for 
the AveREV _SSXF values and 40 m for the Avel0REV values): 

1. 201 l _S-SX_Cr_interpolatedJrom_Avel 0REVtif 

11. 201 l_S-SX_Cr_interpolatedJrom_AveREV_SSXF.tif 

111. These are the rasters shown in Figure 2b. 
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7. Extracted values from the March 2011 water table (Figure I) to the following point shapefiles derived 
from the two-dimensional rasters ofECF-HANFORD-12-0075 (Figure 2a and Figure 2b). These 
points are shown symbolized by concentration in Figure 3a and Figure 3b. 

a. Nitrate point shapefile created from raster 200UPI_Nitrate_Ave_SSX_F9.asc using ArcGIS 
toolbox Conversion Tools > From Raster > Raster to Point: 

1. 2011 _s-sx _ no3 _yoints Jrom _ original _raster_ 050917.shp 

11. Original raster has no concentrations less than 30,000 µg/L (30 mg/L), so this is the minimum 
value for the point shapefile as well 

111. Omitted points in locations disconnected and distant from S-SX tank fann plumes (e.g., see 
omitted areas on Figure 2a) 

b. Chromium point shapefiles created in the process described previously in step 5 of this 
subsection: 

1. 201 l_S-SX_Cr _interpolatedJrom_Avel0REV_0l_051217.shp 

11. 201 l_S-SX_Cr_interpolatedJrom_AveREV_SSXF_0l_051217.shp 

111. Omitted all points with a "GRID_CODE" (origi nal raster) value less than 1.00 (corresponds to 
a concentration a little over IO µg/L, based on the transfonn parameters noted in step 4 of this 
subsection) and omitted points corresponding to plumes disconnected and distant from S-SX 
tank fann plumes (e.g., see omitted area in Figure 2b) 

8. The depth-discrete sample data and the two-dimensional raster concentration values plotted at 
elevations corresponding to the March 2011 water table were consolidated into the following input 
files for import into Leapfrog-Geo: 

a. NO3_Leapfroglnput_02_051517.csv 

b. Cr_Leapfroglnput_02_051517.csv 

2.2 Data Import into Leapfrog-Geo 

I. The point data comprised of raster values and depth-discrete data (files 
NO3_Leapfroglnput_02_051517.csv and Cr_Leapfroglnput_02_05 l 5 l 7.csv discussed above) were 
imported in to Leapfrog-Geo by right-clicking on the "Points" tab in the Project Tree and selecting 
" Import Points" (Points > Import Points). 

a. To improve visualization, increased the vertical exaggeration of the project by clicking on the "Z­
Scale" icon in the lower-right portion of the screen and entering a value of 20 into the dialog box . 

2. A clipping boundary was set by right-clicking the "Topographies" tab in the Project Tree 
(Topographies > Set Clipping Boundary .. . ). Because the coordinates of the input data points are in 
Washington State Plane South (NAD83, 4602, meters), the coordinates for the Leapfrog project are 
implicitly in the same coordinate system, and all imported layers must already be in the same 
coordinate system to be consistent. The following limits were placed on the project area so that only 
data within these boundaries are displayed: 

a. X (East): Minimum = 565,000 m; Maximum= 569,000 m 
b. Y (North): Minimum = 132,500 m; Maximum = 136,000 m 

5 
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3. The water table raster wt_201 l.asc was imported into Leapfrog-Geo using the "Topographies" tab in 
the Project Tree (Topographies > New Topography > Import Elevation Grid). Setting this raster as the 
"Topography" enables it to be set as the upper boundary for the plume interpolation domain. 

4. Shapefiles of roads, buildings, and the S-SX tanks were imported into Leapfrog-Geo using the "GIS 
Data, Maps, and Photos" tab in the Project Tree (GJS Data, Maps, and Photos> Import Vector 
Data .. . ). These were brought in to drape over the Topography layer (here, the water table) for visual 
reference. Beneath Topography in the view menu, GIS Data is selected by pulldown menu. Individual 
shapefiles can be displayed. 

2.3 3-D Interpolation in Leapfrog-Geo 

1. Interpolation is carried out using the bui lt-in interpolation utility in Leapfrog-Geo. The 30 
interpolation is accomplished usi ng the proprietary FastRBF™ algorithm (Carr et al. , 2001 ). The 
interpolation properties/parameters (Boundary, Trend, Value Transform, etc.) are accessed and 
adjusted by double-clicking on the Interpolant item of interest from the Project Tree. 

2. Interpolant items for nitrate and chromium were initially created by selecting the appropriate input 
data set and units and accepting default parameters. This is accessed by right-clicking on the 
"Interpolants" tab in the Project Tree (lnterpolants > New Interpolant). Adjustments to the interpolant 
were made after the plume was created within Leapfrog. 

3. Within the Boundaries tab of the interpolants for nitrate and chromium, the option to use the 
Topography (the year 2011 water table raster, in this case) as the upper boundary for the interpolation 
domain was selected. X and Y values reported below are in the Washington State Plane South ( 4602, 
meters, NAD83) projection. 

4. Parameters used within the Value Transfonn, Trend, lnterpolant, and Outputs tab are reported in 
Section 5, Calculation. Isopleth values used for the creation of plume volumes were chosen to be 
consistent with those used in the 2-D interpolation ofECF-HANFORD-12-0075, with the addition of 
one higher bin to show more detail and aid in selecting interpolation parameters to yield results more 
consistent with input data values. 

6 
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3 Assumptions and Inputs 

Assumptions for the three-dimensional interpolations include the following: 

1. The water table is static and adequately represented by the March 2011 water table raster. 

2. Two-dimensional plume rasters developed in ECF-HANFORD- 12-0075 apply to the upper 
surface of the water table. 

3. The extents of the contaminant plumes are within the saturated portion of the unconfined units 
above the Ringold lower mud. 

Input data for nitrate are included in this report digitally as file N03 _Leapfroglnput_02_051517.csv, and 
input data for chromium are included in this report digitally as file Cr _Leapfrogfnput_02_051517.csv. 
These consist of depth-discrete data placed at the elevation at which samples were collected and values 
converted from the 2D rasters developed in ECF-HANFORD-12-0075 placed at elevations corresponding 
to the year 2011 water table. Details on input data are provided in Section 2.1 above. 

Depth-discrete data for nitrate are included in this ECF as Appendix A, and depth-discrete data for 
chromium are included as Appendix B. Data derived from 2D rasters are only included digitally due to 
their large number. 

7 
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4 Software Applications 

Leapfrog-Geo, Microsoft Excel, and ArcGIS software programs were used for this calculation. These are 
CH2M Hill Plateau Remediation Company (CHPRC) approved software, managed and used in 
compliance with the requirements of PRC-PRO-IRM-309, Controlled Software Management. Leapfrog­
Geo is approved calculation software with the approval documented in CHPRC-01755. Microsoft Excel 
was used as spreadsheet software. ArcGIS was used to extract values from two-dimensional rasters onto 
points, to place and determine projected coordinates of control points, and to manipulate shapefiles and 
their attributes. 

4.1 Approved Software 

Required descriptions for approved calculation software used in this calculation are provided below. 

4.1.1 Description 
Leapfrog-Geo 

• Software Title: Leapfrog-Geo 

• Software Version: 3.0.0 

• Hanford lnfom1ation System Inventory (HISI) Identification Number: 3592 (Safety Software S3 , 
graded to Level C) 

• Authorized Workstation Type and Property Number: INTERA, Incorporated Workstation 
Computer, Property Tag INTERA-00710 

• Authorized User: C. Griffith 

• CHPRC Software Control Documents: 

o CHPRC-01753: Leapfrog-Hydro and Leapfrog-Geo Software Management Plan 

o CHPRC-01754: Leapfrog-Hydro and Leapfrog-Geo Software Test Plan 

o CHPRC-01755: Leapfrog-Hydro and Leapfrog-Geo Acceptance Test Report: Leapfrog-
Hydro Version 2.3.2 and Leapfrog-Geo Version 3.0.0 

4.1.2 Software Installation and Checkout 
The Approved Safety Software package (Leapfrog-Geo) was installed using vendor-provided installation 
files as specified in CHPRC-01753. Installation tests identified in CHPRC-01754 were perfonned and 
successful installation confinned, and Software Installation and Checkout Fonns were completed and 
approved for installations used to perfonn model runs reported in this calculation. A copy of the Software 
Installation and Checkout Fonn is provided in Appendix C of this ECF. 

4.1.3 Statement of Valid Software Application 
The preparers of this calculation attest that the software identified above and used for the calculations 
described in this calculation is appropriate for the application and used within the range of intended uses 
for which it was tested and accepted by CHPRC. Because Leapfrog-Geo is graded as Level C, use of this 
software is logged in the HISI. Accordingly, this ECF has been logged by the software owner in the HISI 
under Identification Number 3592. 
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5 Calculation 

Three-dimensional interpolation was carried out for the two COCs NO3 and Cr. The overall approach was 
kept consistent with the steps described above in the Methodology section of this ECF. Interpolation 
parameters were selected to match existing two-dimensional contours (ECF-HANFORD-12-0075) at the 
water table, to have geometries consistent with the depth-discrete sample data , and to be consistent with 
site knowledge of project scientists. Table 2 shows the interpolation parameters used for the nitrate 
plumes, and Table 3 shows the interpolation parameters used for the chromium plumes. 

Specific considerations for the interpolations are listed below: 

1. When duplicate samples/analyses are avai lable for nitrate or chromium, the highest-value result was 
retained. 

2. Omitted nitrate depth profile result for 299-W22-94. These samples were collected during 2013 and 
near extraction well 299-W22-90 and may therefore not be representative of 2011 conditions. 

3. Omitted nitrate depth profile result for 299-W22-50. These samples were collected 12 years before 
201 1, and data are available from nearby well 299-W22-9 l drilled in 2011. 

4. Only three depth-discrete chromium results were used for 299-W22-47. Chromium results for other 
depths in this well are believed to have been affected by reducing conditions. 

5. Reducing conditions may have occurred at wells 299-W22-89 and 299-W22-96, but chromium depth­
discrete results were retained since they agree with later groundwater sample results collected after 
the wells had been completed. 

6. Interpolated plumes and data were compared to the top of the Ringold Lower Mud surface 
(HS_01121 7 _RLM_elgrd_20m.asc) to detennine if the surface needs to be applied as a lateral extent 
to constrain plume interpolation. For the plumes discussed in this ECF, the bottom of the plumes is 
well above the Ringold Lower Mud, so no steps needed to be taken to constrain them to this surface. 
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Table 2. Interpolation Parameters Used for the Nitrate Plumes in Leapfrog-Geo 

Trend 

Directions Ellipsoid Ratio 

Dip oo Maximum 5 

Dip Azimuth 11 .5° Intermediate 5 

Pitch oo Minimum 

Value Transform 

Type Log 

Pre-transform Clipping: Pre-log Shift -0.849 

Lower Bound 0.85 Bin Count 50 

Upper Bound 536 

lnterpolant 

Type Spheroidal Alpha 3 

Si ll 3,000 Nugget 0 

Range 500 Accuracy 0.7 

Drift None 

Outputs 

Evaluation limits 

Minimum 10 Exact Clipping Yes 

Maximum NA Enclose Intervals 

Default Resolution: 5m 

30 mg/L, 45 mg/L, 100 mg/L, 
Intervals: 200 mg/L 
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Table 3. Interpolation Parameters Used for the Chromium Plumes in Leapfrog-Geo 

Trend 

Directions 

Dip 

Dip Azimuth 

Pitch 

Type 

Pre-transform Clipping : 

Lower Bound 

Upper Bound 

Type 

Sill 

Range 

Drift 

Evaluation limits 

Minimum 

Maximum 

Default Resolution: 

Intervals: 

Ellipsoid Ratio 

o· Maximum 

11 .s· Intermediate 

o· Minimum 

Value Transform 

Log 

Pre-log Shift 

Bin Count 

1,043 

lnterpolant 

Spheroidal Alpha 

3,000 Nugget 

500 Accuracy 

None 

Outputs 

0 Exact Clipping 

NA Enclose 

Sm 

13 µg/L, 48 µg/L, 100 µg/L, 
200 µg/L, 480 µg/L 
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6 Results/ Conclusions 

Figure 4 shows the three-dimensional plumes for nitrate, and Figure 5 shows the three-dimensional 
plumes for chromium in the 200 West Area near and down-gradient of the S-SX tank fann. These figures 
show the plumes as three-dimensional volumes and input data points with values at or above 30 mg/L for 
nitrate and 13 µg/L for chromium. The Leapfrog-Geo 3.0.0 project file for these plumes is stored on 
EMMA, indexed to this ECF. Leapfrog Viewer 4.6 fi les for the two plumes are also stored on EMMA. 
These files are opened with the free Leapfrog Viewer, which is available at 
http://www.leapfrog3d.com/products/leapfrog-viewer. 
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Figure 1. Year 201 1 Water Table Raster in the Vicinity of the S-SX Tank Farm 
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Figure 2. Two-dimensional Plume Raster Subsets and Wells with Discrete-depth Groundwater Sample Data used in the Development of Three­
dimensional plumes for (a) Nitrate and (b) Chromium 
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Figure 3 
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Figure 3. Points Derived from Plume Rasters and Placed at the March 2011 Water Table used in the Development of Three-dimensional Plumes for (a) 
Nitrate and (b) Chromium 

16 



ECF-200W-17-0097, REV. 0 

Map View 

Facing North 

Figure 4 
Interpolated nitrate plumes with concentrations of 30 mg/L 
or greater in the vicinity of the 5-SX tank farm 
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The upper surface of the plumes is the 2011 water table. 
Vertical exaggeration = 20x. 

Figure 4. Interpolated Nitrate Plumes with Concentrations of 30 mg/Lor Greater in the Vicinity of the S-SX Tank Farm 
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Figure 5 
Interpolated chromium plumes with concentrations of 13 ug/L 
or greater in the vicinity of the S-SX tank farm 

Oblique View from Southeast 

Facing West 

Colored volumes indicate concentration intervals: 
Blue: 13 to 48 ug/L 
Green: 48 to 100 ug/L 
Orange: 100 to 200 ug/L 
Red : 200 to 480 ug/L 
Purple: > 480 ug/L 

The upper surface of the plumes is the 2011 water table. 
Vertical exaggeration = 20x. 

Figure 5. Interpolated Chromium Plumes with Concentrations of 13 µg/L or Greater in the Vicinity of the 5-SX Tank Farm 
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Appendix A 

Depth-Discrete Data Used in the 3-D Plume Interpolation for Nitrate 
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Table A 1. Depth-Discrete Data Used in the 3-0 Plume Interpolation for Nitrate 

Well Name 
Land Surface Elev. Sample Depth Easting Northing Sample Elevation Nitrate Nitrate 

(mmsl) (m bis) (X, m) (Y, m) (Z, m msl) (µg/L) (mg/L) 

299-W22-47 205.533 70.41 566908.74 134076.28 135.123 176000 176 

299-W22-47 205.533 71.63 566908.74 134076.28 133.903 456000 456 

299-W22-47 205.533 73.15 566908.74 134076.28 132.383 469000 469 

299-W22-47 205.533 74.07 566908.74 134076.28 131.463 536000 536 

299-W22-47 205.533 75.59 566908.74 134076.28 129.943 478000 478 

299-W22-47 205.533 77.11 566908.74 134076.28 128.423 491 000 491 

299-W22-47 205.533 78.64 566908.74 134076.28 126.893 487000 487 

299-W22-47 205.533 80.16 566908.74 134076.28 125.373 478000 478 

299-W22-47 205.533 81 .99 566908.74 134076.28 123.543 483000 483 

299-W22-47 205.533 83.21 566908.74 134076.28 122.323 327000 327 

299-W22-47 205.533 84.73 566908.74 134076.28 120.803 352000 352 

299-W22-47 205.533 86.26 566908.74 134076.28 119.273 400000 400 

299-W22-47 205.533 87.78 566908.74 134076.28 11 7.753 362000 362 

299-W22-47 205.533 89.31 566908.74 134076.28 116.223 216000 216 

299-W22-47 205.533 90.83 566908.74 134076.28 114.703 338000 338 

299-W22-47 205.533 92 .35 566908.74 134076.28 113.183 63300 63.3 

299-W22-47 205.533 93.88 566908.74 134076.28 111 .653 17800 17.8 

299-W22-47 205.533 95.4 566908.74 134076.28 110.133 29500 29.5 

299-W22-47 205.533 96.93 566908.74 134076.28 108.603 19600 19.6 

299-W22-47 205.533 98.45 566908.74 134076.28 107.083 10700 10.7 

299-W22-47 205.533 99.97 566908.74 134076.28 105.563 36900 36.9 
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Table A1. Depth-Discrete Data Used in the 3-D Plume Interpolation for Nitrate 

Well Name 
Land Surface Elev. Sample Depth Easting Northing Sample Elevation Nitrate Nitrate 

(m msl) (m bis) (X, m) (Y, m) (Z, m msl) (µg/L) (mg/L) 

299-W22-47 205.533 101 .5 566908.74 134076.28 104.033 9690 9.69 

299-W22-47 205.533 104.5 566908.74 134076.28 101 .033 6020 602 

299-W22-47 205.533 106.1 566908.74 134076.28 99.433 6510 6.51 

299-W22-47 205.533 103 566908.74 134076.28 102.533 7750 7.75 

299-W22-86 205.7 76.2 567186.74 134041 .31 129.5 23000 23 

299-W22-86 205.7 81 .38 567186.74 134041 .31 124.32 19000 19 

299-W22-86 205.7 88.39 567186.74 134041 .31 117.31 15000 15 

299-W22-86 205.7 94.49 567186.74 134041 .31 111 .21 7000 7 

299-W22-86 205.7 89.92 567186.74 134041 .31 115.78 7000 7 

299-W22-86 205.7 97 .54 567186.74 134041 .31 108.16 7000 7 

299-W22-86 205.7 106.7 567186.74 134041.31 99 6000 6 

299-W22-90 207.07 76.566 566961 .39 134483.24 130.504 254000 254 

299-W22-90 207.07 83.119 566961.39 134483.24 123.951 14600 14.6 

299-W22-90 207.07 89.215 566961 .39 134483.24 117.855 4430 4.43 

299-W22-90 207.07 95.1 566961 .39 134483.24 111.97 2170 2.17 

299-W22-91 204.4 73.46 566911 .76 134134.53 130.94 77000 77 

299-W22-91 204.4 80.16 566911 .76 134134.53 124.24 226000 226 

299-W22-91 204.4 86.38 566911 .76 134134.53 118.02 24300 24.3 

299-W22-91 204.4 92.111 566911.76 134134.53 112.289 850 0.85 

299-W22-92 205.558 74.646 567167.84 134029.77 130.912 54000 54 

299-W22-92 205.558 80.833 567167.84 134029.77 124.725 69100 69.1 
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Table A1 . Depth-Discrete Data Used in the 3-0 Plume Interpolation for Nitrate 

Well Name 
Land Surface Elev. Sample Depth Easting Northing Sample Elevation Nitrate Nitrate 

(mmsl) (m bis) (X, m) (Y, m) (Z, m msl) (µg/L) (mg/L) 

299-W22-92 205.558 86.56 567167.84 134029.77 118.998 18200 18.2 

299-W22-92 205.558 93.27 567167.84 134029.77 112.288 41300 41.3 

299-W22-95 208.264 78.675 567170.54 134549.11 129.589 37500 37.5 

299-W22-95 208.264 80.9092 567170.54 134549.11 127.3548 20100 20.1 

299-W22-95 208.264 90.0471 567170.54 134549.11 118.2169 8370 8.37 

299-W22-95 208.264 96.865 567170.54 134549.11 111 .399 1130 1.13 

299-W22-96 208.501 77 .72 567351 .93 134145.58 130.781 24700 24.7 

299-W22-96 208.501 83.637 567351.93 134145.58 124.864 6060 6.06 

299-W22-89 205.457 78.33 566906.77 134031 .67 127.127 7920 7.92 

299-W22-89 205.457 81.412 566906.77 134031 .67 124.045 8190 8.19 

299-W22-89 205.457 89.154 566906.77 134031 .67 116.303 1450 1.45 

299-W22-89 205.457 95.555 566906.77 134031 .67 109.902 2900 2.9 

299-W22-89 205.457 101 .38 566906.77 134031 .67 104.077 1570 1.57 

bis = below land surface 

msl = mean sea level 
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Appendix B 

Depth-Discrete Data Used in the 3-D Plume Interpolation for Chromium 
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Table 81. Depth-Discrete Data Used in the 3-D Plume Interpolation for Chromium 

Well Name 
Land Surface Elev. Sample Depth Easting Northing Sample Elevation Chromium 

Note (mmsl) (m bis) (X, m) (Y, m) (Z, m msl) (µg/L) 

299-W22-47 205.533 75.59 566908.74 134076.28 129.943 196 

299-W22-47 205.533 81 .99 566908.74 134076.28 123.543 235 

299-W22-47 205.533 87.78 566908.74 134076.28 117.753 142 

299-W22-89 205.457 78.33 566906.77 134031 .67 127.127 <13 Plotted at detection limit 

299-W22-89 205.457 81.412 566906.77 134031 .67 124.045 <13 Plotted at detection limit 

299-W22-89 205.457 89.154 566906.77 134031 .67 116.303 <13 Plotted at detection limit 

299-W22-89 205.457 95.555 566906.77 134031.67 109.902 <13 Plotted at detection limit 

299-W22-89 205.457 101 .38 566906.77 134031.67 104.077 <13 Plotted at detection limit 

299-W22-96 208.501 77.72 567351 .93 134145.58 130.781 1.59 

299-W22-96 208.501 83.637 567351 .93 134145.58 124.864 <1 Plotted at detection limit 

bis = below land surface 

msl = mean sea level 
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Appendix C 

Software Installation and Checkout 
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CHPRC SOFTWARE INSTALLATION AND CHECKOUT FORM 

Software Owner Instructions: 
Complete Fields 1-13, then run test cases in Field 14. Compare test case results listed in Fie ld 15 to corresponding Test Report outputs. 
If results are the same, sign and date Field 19. If not, resolve differences and repeal above steps. 

Software Subject Matter Expert Instructions: 
Assign test personnel. Approve the installation of the code by signing and dating Field 21 , then maintain form as part of the software 
support documentation. 

GENERAL INFORMATION: 

1. Software Name: _L_e_a=...p_f_r_o-"-g_G_e_o _____________________ _ 

EXECUTABLE INFORMATION: 

2. Executable Name (include path): 

3. Executable Size (bytes): 55 7 5 KB 

COMPILATION INFORMATION: 

4. Hardware System (i.e., property number or ID): 

Vendor suppl i ed 

5. Operating System (include version number): 

Windows (Vendor supplied) 

INSTALLATION ANO CHECKOUT INFORMATION: 

6. Hardware System (i.e., property number or ID): 

INTERA-0 071 0 

7. Operating System (include version number): 

Windows 10 Pro - Version 1607 

8. Open Problem Report? 0 No O Yes 

TEST CASE INFORMATION: 
9. Directory/Path: 

10. Procedure(s): 

PR/CR No. 

p er CHPRC-01754 Rev 0, Leapfrog Hydro Software Test Pl an 

11 . Libraries: 

N/A 

12. Input Files: 

p er CHPRC-01754 Rev 0 , Leapfrog Hydro Sof tware Test Plan 

13. Output Files: 

per CHPRC-0 1754 Rev 0 , Leapfrog Hydro Software Test Plan 

14. Test Cases: 

Ven dor Inslal l ation Pa c kage, TC-1, TC- 2 , TC- 3 , TC-4 

15. Test Case Results: 

Pass 

16. Test Performed By: Cl ark Griffith ( INT ERA) 

17. Test Results: 0 Satisfactory, Accepted for Use O Unsatisfactory 

18. Disposition (include HISI update): 

i 

Accepted; i nstal l a tion added to Hanford Off-Site user list 

Page 1 of 2 
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CHPRC SOFTWARE INSTALLATION AND CHECKOUT FORM (continued) 

1. Software Name: Leapfrog Ge o Software Version No.: 3 . 0 . 0 

" "'"~" "' Bv· 

19. WE Ni c ho l s 
Software owner (Signature) Print Date 

20. Test Personnel: 

~~ Clark Griffith I \/1 -&/-201, 
Sign Print Date 

Sign Print Date 

Sign Print Date 

Approved By: 

21 . N/R pe r SMP 
Software SME (Signature) Print Date 

Page 2 of 2 A-6005-149 (REV 0) 
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